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1 Conventions and Trademarks

1.1 Typographic conventions

Caution used with the safety alert symbol, indicates a hazardous situation
which, if not avoided, could result in minor or moderate injury or material
damage.

Information intended to help the user achieve optimal use of the software.
Includes usage considerations, limitations, or recommendations that do
not relate to safety.

A reminder to the user of their responsibilities under applicable regulatory
requirements.

A Key A at the keyboard.
Ctrl-A Control key. Hold down Ctrl key and A simultaneously.

Icon in toolbar.
*.mat Filename extension.
C:/Program Folder.
File Menu, e.g. File menu.
File→Save As Sub menu, e.g. under the File menu the item Save As is found.
Close Push/Toggle button in the graphical user interface.
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2 Requirements

2.1 System requirements

� Operating System:

� Windows 11

� Windows Server 2019

� Processor: Any Intel or AMD x86-64 processor with a minimum of four logical cores

� Computer with 8 GB of memory or preferably 16 GB

� Harddisk with at least 5 GB of available space

� Graphics card supporting both DirectX and OpenGL

� To use the full functionality of the report function:

� Microsoft Word

� Adobe PDF reader

� To access full version of machine learning algorithms in Segment:

� CUDA enabled NVIDIA graphics card with 4 GB memory or more

� GPU architecture: Ampere, Turing, Volta, Pascal

� For users with additional modules not included in the free research version:

� Internet connection for software license management and software download. We
recommend a speed of at least 24 Mbit/s.

Recommendations

� Systems with two screens

� Using SSD disk for reading data

2.1.1 Mac OS users

Please refer to the section "I have a Mac" in our FAQ (www.medviso.com/faq).

2.2 Safety Instructions

Caution used with the safety alert symbol, indicates a hazardous situation which, if not
avoided, could result in minor or moderate injury or material damage. Caution consists of
the following elements:

� Information about the nature of a hazardous situation,

� Consequences of not avoiding a hazardous situation, and
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2.2 - SAFETY INSTRUCTIONS

� Methods of avoiding a hazardous situation.

The following cautions are valid for Segment:

.
CAUTION: The measurement results may not re�ect the exact situation because
the measurements are inaccurate.
Minor inaccuracy of value(s) in patient record. No harm to patient.

� Correct volumetric measurement and tissue characteristics values greatly
depend on the �nal segmentation,

� Manually check and, if necessary, correct the algorithm segmentation re-
sults using your clinical knowledge,

� The automatic segmentation algorithms provides an initial assumption of
contour de�nitions. It is the responsibility of the user to verify and correct
the results,

� Review the patient report for errors prior transmitting the �nal result,

� Quantitative analysis is dependent on the quality and correctness of the
image source data,

� The software may only be used by professionals trained in cardiac MR
image analysis,

� Segment is a support tool that provides relevant clinical data as a resource
to the clinician and is not intended to be a source of medical advice or to
determine or recommend a course of action or treatment for a patient.

.
CAUTION: The automatic scar and MaR segmentation algorithms are devel-
oped for single vessel myocardial infarction or ischemia. They are not validated
for multi-vessel myocardial infarctions or ischemia.
Extra work for user, since the user must do the segmentation manu-
ally for multi-vessel myocardial infarctions or ischemia. No harm to
patient.

� Correct volumetric measurement and tissue characteristics values greatly
depend on the �nal segmentation,

� Manually check and, if necessary, correct the algorithm segmentation re-
sults using your clinical knowledge,

� The automatic segmentation algorithms provides an initial assumption of
contour de�nitions. It is the responsibility of the user to verify and correct
the results,
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2.2 - SAFETY INSTRUCTIONS

.
CAUTION: The 4D �ow analysis is only validated for Siemens data.
Extra work for user, since �ow analysis for data from non-Siemens
vendors must be done using the 2D �ow analysis tools. No harm to
patient.

� For 4D �ow data acquired from non-Siemens vendors, perform �ow analy-
sis using validated 2D �ow analysis tools instead of the 4D �ow work�ow.

.
CAUTION: The user reads a revision of the user manual that di�ers from their
software revision, so the user gets incorrect information on how to use the soft-
ware.
Extra work for user, since the software cannot be used. No harm to
patient.

� Ensure the version number of your Instructions for Use corresponds to
your software version number. The correct Instructions for Use for your
software can always be found under the Help menu, while the latest can
be found on the Medviso webpage.

.
CAUTION: Antivirus software has not been installed or updated.
Patient stress and/or anxiety.

The computer where Segment is installed should have:

� Firewall,

� Anti-virus software installed and running,

� Back-up on patient data, and

� Personal login to access the software (in the preferences for Segment the
user can activate user login to the device and user logging for the usage
of the device.)

ò
Each MRI scanner is unique and di�erent phase contrast pulse sequences have
to be individually validated for each scanner, as each scanner has individual
sources of error that can a�ect �ow quanti�cation.

-
In the event that the use of Segment causes a serious incident, such that it
results in physical OR psychological harm to the user and/or patient, this shall
immediately be reported to Medviso AB (support@medviso.com), as well as
the competent authority of your Member State (Ministries/Agencies of Health
and/or Medicines).
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3 IT Network and security

When installing and operating Segment on an IT network (a system or systems composed
of communicating nodes), the following requirements must be met:

Technical speci�cations
Adequate protection against malware (malicious software) or similar threats must be imple-
mented.

Information �ow
Segment can connect to an organisation's PACS or other DICOM node. Ensure that net-
work ports are available for communication. Adding Segment to the PACS whitelist can
help ensure smooth information �ow.

Hazardous situations
If the IT network does not comply with the requirements listed above, hazardous situations
may occur.
These may include, for example:

� incorrect or delayed data transfer,

� system unavailability, or

� compromised data security.

3.1 Segment on an IT network

When Segment is installed and becomes part of an IT network, please be aware of the
following:

1. Running Segment as part of an IT network may introduce risks to patients, users, or
third parties that have not been previously identi�ed.

2. It is the responsibility of the user to identify, analyse, evaluate, and control these risks
before deployment.

3. Any subsequent changes to the IT network, may introduce new risks and may require
additional analysis. Such changes to the IT network may include:

� modi�cations to the IT network con�guration,

� addition of hardware, software platforms, or software applications,

� removal of items from the IT network,

� updates to hardware or software platforms or software applications,

� upgrades to hardware or software platforms or software applications.
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3.2 - ADDING MATLAB WEBSITE TO NETWORK FIREWALL

3.2 Adding Matlab website to Network �rewall

If your organization is running a network �rewall, it is need to bypass blocked connections
to the MathWorks servers in order to install Matlab Runtime that is packaged together with
Segment CMR in the installation process.

The MathWorks installer contacts MathWorks servers on the following ports and addresses:

� login.mathworks.com

� services.mathworks.com

� TCP ports 80 and 443

Your �rewall needs to bypass blocked connections for both addresses over both ports. These
servers do not use a Static IP Address and will resolve to a Dynamic IP Address. This
means that users will not be able to white-list MathWorks servers via IP Address and will
have to use the domain name. More information about possible solutions for unblocking the
connection can be found in provided link below.

Source: https://se.mathworks.com/matlabcentral/answers/92634-why-do-i-get-a-connection-
error-when-installing-or-activating-matlab-or-another-mathworks-product

3.3 Adding Licence Server to Network �rewall

If your organization is running a network �rewall, it is need to open network �rewall for
Medviso Licence Server in order to verify and update your Software licence.

Segment CMR contacts Medviso Licence Server on the following address and port:

� URL: https://medviso.com

� Port: 443
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4 Installation guide

4.1 Installation and upgrading

To install or upgrade Segment, log in to our website (https://medviso.com/download2/) and
download the installation �le. Run the installation �le under administrator privileges on the
machine and follow the instructions in the �gures below.

For more information on installation and network connectivity, please consult the separate
installation manual found on our website (https://medviso.com/user-manuals2/). For assis-
tance, please contact support@medviso.com.

Figure 1: The installation starts automatically. Do not close this window, it will close
automatically when the installation is completed.

Figure 2: Click on Next.
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4.1 - INSTALLATION AND UPGRADING

Figure 3: Select Add a shortcut to the desktop. Click on Next.

For �rst time installation, Matlab Compiler Runtime (MCR) needs to be installed according
to Figure 4 - 7. For upgrading, continue according to Figure 8.

Figure 4: Click on Next.
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4.1 - INSTALLATION AND UPGRADING

Figure 5: Select Yes. Click on Next.

Figure 6: Click on Install.
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4.1 - INSTALLATION AND UPGRADING

Figure 7: Wait for completed process.

For upgrading, only install Segment according to Figure 8 - 9.

Figure 8: Click on Next.
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4.1 - INSTALLATION AND UPGRADING

Figure 9: Click on Install.

For �rst time installation or upgrading, continue according to Figures 10 - 11.

Figure 10: Wait for completed process.
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4.2 - FIRST TIME RUNNING SEGMENT

Figure 11: Click on Finish.

4.2 First time running Segment

The �rst time you run the software to con�gure it you need to run the software as Admin-
istrator. Right click on the shortcut to the software and select Run as administrator. Note
that it is not su�cient to be logged in as administrator on the computer.

The �rst time Segment is started, it runs a setup process which can take a while, so be
patient. When starting the software, the image in Figure 12 should be displayed. If it is not
displayed, then the software is not correctly installed.

To complete the setup, set preferences and window positions as described in Sections 4.2.1
and 4.2.2.

4.2.1 Setting preferences

It is recommended to set the preferences of which folders to use to avoid browsing each time

you want to load or save a �le. It is invoked by using the icon (p). Set Data, Export
and CD folders.

4.2.2 Setting window positions

The position of the main window for Segment can be set by dragging the window to an
optional position and size. The size and position will be saved so that next time Segment
is launched the same position will be used. In case where one have switched to another
monitor, Segment may move outside the screen. In this case you could press Ctrl-0 to reset
GUI positions. This is also available under the File menu (a).

4.2.3 PACS connection

This module is an commercial available module, that is not included in the free research
version. Please contact Medviso Sales team (sales@medviso.com) for more information and

6



4.3 - ADD SOFTWARE LICENSE CODE

Figure 12: Startup window for Segment.

a quote.

Setting up PACS connection and Segment Server usually requires help from your local PACS
support, and we recommend that you contact us to setup a telephone / web-based video con-
ference to make this process as smooth as possible. The Database and PACS connection
manual and the Sectra PACS plugin manual is found at Medviso AB homepage
(https://medviso.com/user-manuals). The Sectra PACS plugin may require additional Mi-
crosoft Visual C++ components that can be downloaded from Medviso AB homepage
(https://medviso.com/download2/).

4.3 Add software license code

This section only applies if you have a commercial purchased license for Segment, for the
free research version no license is needed. For new installations you need to add your license
code for Segment. Add your license code after installation by starting Segment and select
Setup License under the Settings menu in Segment. Note that you have to run the software
as Administrator to be able to add the license code in Segment. If you have lost the license
code, please contact sales@medviso.com.

4.4 Uninstallation

To uninstall Segment, go to Control Panel and select Uninstall a program (Figure 13). Search
for Segment in the programs list, right-click on it and select Uninstall/Change. Do the same
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4.5 - SOFTWARE OVERVIEW

steps for uninstalling MATLAB Runtime, but select MATLAB Runtime in the programs list.

User preferences are stored in AppData, in the subfolder Segment under each user account.

Figure 13: Control Panel

4.5 Software overview

An overview of Segment is given in Figure 14.

To learn more about each tool, hold the mouse over the icon in the software and a help text
will be displayed. To exit the software, simply press the x-button in the top right corner.

4.6 Software upgrade

When upgrading to new software version you can just install a new version over the old
version. The versions are always backwards compatible and settings are kept. If you have
activated services for Segment to work as a DICOM node, then these services need to be
stopped during the upgrade process. How to do this is illustrated in Figure 15. The services
may also be stopped directly with Windows service manager by typing services.msc in the
Windows search box.

The services can be restarted after upgrade is complete. The services will also be automati-
cally restarted when the computer is restarted.

4.7 Trouble shooting

To trouble shoot the installation you can see if the Segment installation program actu-
ally was successfully started by checking for the existence of .log �les. Segment cre-
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4.7 - TROUBLE SHOOTING

Figure 14: Main graphical user interface.

Figure 15: Stop services button in the Manual Installation of Segment Services window.
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4.7 - TROUBLE SHOOTING

ates a log �le during installation, this �le is stored in the user folder (i.e Documents and

Settings/Username and Application Data and the subfolder Segment. Note that this
folder by default is hidden. If you have problems installing Segment, please send this log-�le
to support@medviso.com together with a description on what problems where encountered.

In case the software runs then you can access the log-�les under the Help menu and Open

Folder with Log Files .

4.7.1 Segment fails to install

The most probable cause is not to run the installation software as administrator. Another
problem may be that have no Internet connection during installation.

4.7.2 Segment fails to start after installation

If the software fails to start after installation without or with error messages, that means that
the installation process was not completed successfully Please refer to the section "Program
won't start" in our FAQ (www.medviso.com/faq) for further support.

4.7.3 No compatible GPU con�guration detected

Segment fails to �nd a compatible NVIDIA graphics card. Firstly check that the card is
correctly installed and meet the performance. We recommend to download the tool GPU-Z
from Techpowerup for this purpose (www.techpowerup.com/download/techpowerup-gpu-z).
If you have one card installed that should match the requirements on possible cause may be
that your operating system is blocking GPU usage either for compability reasons or power
saving reasons.

Figure 16: Select display settings by right click on desktop.

4.7.4 Sudden software crash

This is most likely caused by old NVIDIA graphics driver, please see Section 4.7.5. For
getting help general crashes please send log-�les to support@medviso.com. See details on
where to

4.7.5 Update NVIDIA graphics driver to latest version

Please note that although you use Windows update and this process claims all drivers to be
updated this is likely not the case for the NVIDIA graphics card driver. To install a new
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4.7 - TROUBLE SHOOTING

Figure 17: Select Graphics settings.

Figure 18: Select Browse, and select folder where Segment is installed. Select application.
Select High Performance.

version, go to http://nvidia.co.uk/Download/index.aspx. Select you graphics card details
and press Search. Follow instructions on how to download and install. See also under
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4.7 - TROUBLE SHOOTING

Section 4.7.3 on how to see GPU details and driver version details.

12


	Conventions and Trademarks
	Typographic conventions

	Requirements
	System requirements
	Mac OS users

	Safety Instructions

	IT Network and security
	Segment on an IT network
	Adding Matlab website to Network firewall
	Adding Licence Server to Network firewall

	Installation guide
	Installation and upgrading
	First time running Segment
	Setting preferences
	Setting window positions
	PACS connection

	Add software license code
	Uninstallation
	Software overview
	Software upgrade
	Trouble shooting
	Segment fails to install
	Segment fails to start after installation
	No compatible GPU configuration detected
	Sudden software crash
	Update NVIDIA graphics driver to latest version



